erwjg

erwin Data Modeler

Navigator Edition User Guide

Release 12.5



Legal Notices

This Documentation, which includes embedded help systems and electronically distributed
materials (hereinafter referred to as the “Documentation”), is for your informational pur-
poses only and is subject to change or withdrawal by Quest Software, Inc and/or its affiliates
at any time. This Documentation is proprietary information of Quest Software, Inc and/or its
affiliates and may not be copied, transferred, reproduced, disclosed, modified or duplicated,
in whole or in part, without the prior written consent of Quest Software, Inc and/or its affil-
iates

If you are a licensed user of the software product(s) addressed in the Documentation, you
may print or otherwise make available a reasonable number of copies of the Documentation
for internal use by you and your employees in connection with that software, provided that
all Quest Software, Inc and/or its affiliates copyright notices and legends are affixed to each
reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the
period during which the applicable license for such software remains in full force and effect.
Should the license terminate for any reason, it is your responsibility to certify in writing to
Quest Software, Inc and/or its affiliates that all copies and partial copies of the Docu-
mentation have been returned to Quest Software, Inc and/or its affiliates or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, QUEST SOFTWARE, INC. PROVIDES THIS
DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL QUEST SOFTWARE, INC. BE LIABLE TO
YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE
USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST
INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF QUEST
SOFTWARE, INC. IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR
DAMAGE.

The use of any software product referenced in the Documentation is governed by the applic-
able license agreement and such license agreement is not modified in any way by the terms
of this notice.

The manufacturer of this Documentation is Quest Software, Inc and/or its affiliates.



Provided with “Restricted Rights.” Use, duplication or disclosure by the United States
Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and
52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their suc-
cessors.

Copyright © 2025 Quest Software, Inc and/or its affiliates All rights reserved. All trademarks,
trade names, service marks, and logos referenced herein belong to their respective com-

panies.



Contact erwin

Understanding your Support

Review support maintenance programs and offerings.

Registering for Support
Access the erwin support site and register for product support.
Accessing Technical Support

For your convenience, erwin provides easy access to "One Stop" support for all editions of
erwin Data Modeler, and includes the following:

Online and telephone contact information for technical assistance and customer ser-
vices

Information about user communities and forums
Product and documentation downloads

erwin Support policies and guidelines

Other helpful resources appropriate for your product

For information about other erwin products, visit http://erwin.com/products.

Provide Feedback

If you have comments or questions, or feedback about erwin product documentation, you
can send a message to techpubs@erwin.com.

News and Events

Visit News and Events to get up-to-date news, announcements, and events. View video demos

and read up on customer success stories and articles by industry experts.
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Working with erwin Data Modeler Navigator Edition

Working with erwin Data Modeler Navigator Edition

This section contains the following topics

Intended Audience

erwin Data Modeler Navigator Edition

Modeling Overview

The Application Development Cycle
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Intended Audience

Intended Audience

This guide is intended for use by individuals such as business or system analysts, database
designers, and programmers who require read-only access to models created in erwin Data
Modeler (erwin DM). You can use erwin Data Modeler Navigator Edition to view, print, and
manipulate models. The only limitation is that you cannot save any type of model change,
including any made to models accessed in a mart database.

Starting erwin Mart Portal 12.1, erwin DM Navigator Edition works only with erwin Mart
Portal on premises. For erwin Mart Portal on Cloud, explore erwin ER360. For more
information or assistance, contact erwin Support.

You can use this product on data models that are on a local drive, network drive, orin a
mart database to:

" View the work of others while it is in progress.

" Provide input without inadvertently changing work.

" Read the information in a model in order to create queries, reports, or applications.
If you are already familiar with erwin Data Modeler, erwin Data Modeler Navigator Edition

offers most of the features currently available in the full-feature version of these products.

For more information about product differences, see erwin Data Modeler Navigator Edition Dif-
ferences.

To use this product with data models, you should have a working knowledge of database
management, entity-relationship diagrams, and IDEF1X and IE data modeling terms. If you
are using a data warehousing environment, you should also have a working knowledge of
dimensional modeling terms.
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erwin Data Modeler Navigator Edition

erwin Data Modeler Navigator Edition

erwin Data Modeler Navigator Edition is one of the editions of erwin Data Modeler. These
editions provide a foundation for building, deploying, and managing applications. These edi-
tions consist of project management, change and configuration management, modeling and
design, and knowledge publication and visualization. They strengthen your ability to auto-
mate critical application life cycle processes and to thrive in the increasing complexity and
rate of change in today's business climate. They help you simplify the complex aspects of
analyzing, designing, and implementing applications by providing a visualization of the rela-
tionships between business and technology. The key editions that provide the integration of
design and data models are:

" erwin Data Modeler Standard Edition--The essential tool for data modeling.

" erwin Data Modeler Workgroup Edition--Supports concurrent team modeling for large
client/server development projects.

Starting erwin Mart Portal 12.1, erwin DM Navigator Edition works only with erwin Mart
Portal on premises. For erwin Mart Portal on Cloud, explore erwin ER360. For more
information or assistance, contact erwin Support.
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Modeling Overview

Modeling Overview

Modeling is one of the most effective techniques for understanding and communicating busi-
ness rules and processes. Just as an architect creates a blue print before building a struc-
ture, a database designer creates a data model before building a database. A data model is a
graphical representation of a database that is used to capture an organization's business
rules, which can then be used to define a system's requirements.

Typically, throughout the design process, a model is presented to business users and other
members of the enterprise for review and input. As a reviewer of a data model, you may be
required to provide input to the design team.

This product is a read-only version of the erwin® Data Modeler database modeling tool
when you are working with data models. You can use it to create, open, manipulate, print,
and report on any data model. This product maintains most of the functionality of the full-
feature version, but you cannot use it to save a data model or to forward or reverse engin-
eer a database.

You can also use erwin® Data Modeler Navigator Edition to open models saved in a shared
database that was created using erwin® Data Modeler Workgroup Edition. If you want to be
able to access a mart database, contact your mart administrator. The administrator must
create a mart database on a supported DBMS and a security profile for each user. Your PC
must have the appropriate DBMS client connection software before you can access models
in a mart database, and you must have the appropriate security permissions. See the erwin@
Data Modeler Workgroup Edition Administration Guide for more information.
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The Application Development Cycle

The Application Development Cycle

To create a data model, first the business rules are gathered and the logical constructs are
created. Next, the physical design is created, and then a database is implemented. erwin
DM supports this iterative process by supporting multiple platforms, reuse of objects, and
synchronization of changes between data models.
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Installation

Installation

This section contains the following topics

Install erwin Data Modeler Navigator Edition

Post-Installation
Install the SSL Certificate

erwin DM Navigator Edition User Guide
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Install erwin Data Modeler Navigator Edition

Install erwin Data Modeler Navigator Edition

The Installation Wizard makes it easy for you to install, change, or remove the software.
To install erwin Model Navigator:
1. Double-click the file you downloaded from the online erwin product page.
The Installation Wizard opens.
2. Follow the prompts in the wizard to proceed.
A License Agreement opens for you to review.

3. Select the option to accept the terms as described in the License Agreement. Click
Next.

The wizard asks a series of questions you must answer, including:
" Customer Information
" Destination folder
" License Code

4. On the Custom Setup Type screen, review the program features that will be installed.
You can also evaluate the space needed to install each feature.

Click Next to continue and then click Install to start the installation.

The program files are copied.
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Uninstall the Navigator Edition

Uninstall the Navigator Edition

There is a known issue with uninstalling the Navigator Edition.
Symptom:

Suppose that you have installed erwin® Data Modeler and the Navigator Edition on the
same computer, through separate installations. For example, suppose that you have
installed erwin® Data Modeler using the erwin® Data Modeler r9.2.0 installation wizard and
you have installed the Navigator Edition using the erwin Model Navigator installation wiz-
ard. When you uninstall the Navigator Edition, the following messages appear:

Error 1905 Module C:\Program Files (x86)\erwin\Navigator r9\EAL.d1l1l
failed to unregister. HRESULT-2147220472. Contact your support
personnel.

Error 1905 Module C:\Program Files (x86) \erwin\Navigator
r9\ERXML.d11 failed to unregister. HRESULT-2147220472. Contact
your support personnel.

Solution:
Reregister the ERXML.dIl and EAL.dII files manually in erwin® Data Modeler again.
To avoid this problem, install erwin Model Navigator and erwin® Data Modeler from the

same installation wizard. That is, select the erwin Model Navigator r9.2.0 component in
the erwin® Data Modeler r9.2.0 installation wizard.
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Post-Installation

Post-Installation

Before you can view models in a mart database, you need to connect to the mart database
on which the models reside. The connection is made by clicking Mart, Connection on the
File menu. The following must be performed before you can connect to a mart database:

" The client connectivity software for your host DBMS must be installed on the client
workstation so that you can connect to the DBMS on which the mart database
resides.

" The mart administrator must give you permission to access the mart database.
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Install the SSL Certificate

Install the SSL Certificate

If you have enabled SSL for the Mart, install the SSL certificate. Install the certificate on the
computer from which you plan to use the Navigator Edition with erwin® Data Modeler.

Follow these steps:
1. Open a web browser and go to https://servername:18170:MartAdmin.
The server name is the hostname of the server where the Mart is SSL enabled.
2. Click Certificate Error in the Address bar and then click View Certificate.
3. Click Install Certificate in the Certificate window.

4. Install the certificate under the Trusted Root Certification Authorities certificate store.

You can now connect to an SSL-enabled Mart from the erwin® Data Modeler Nav-
igator Edition.
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Navigating Data Models

Navigating Data Models

This section contains the following topics

Data Models
Basic Data Modeling Concepts

Workplace Panes

Open an Existing Model
Open a Model Saved in XML Format (XML Import)

Connect to Mart
Open a Model from the Mart
Customizing the Appearance of Data Models

Print a Data Model

erwin DM Navigator Edition User Guide
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Data Models

Data Models

The erwin Data Modeler Navigator Edition contains the tools you need to open, view, manip-
ulate, print, and report on erwin Data Modeler (erwin DM) data models.

Although the Toolbox and other features are enabled, you cannot save the changes you
make to a data model. This product only maintains the changes that you make to a data
model until you close the model. If you need to save your changes, you can upgrade to the

full-feature edition.
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Basic Data Modeling Concepts

Basic Data Modeling Concepts

Before creating or working with data models, there are some basic data modeling concepts
that you must be familiar with. These concepts include:

Model Types

Entities
" Tables
Attributes and Columns
Primary Key
Relationships

Foreign Key
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Model Types

Model Types

Multiple model types allow data modelers or data analysts to work with the models best
suited for their needs. The following model types are available:

Logical

A conceptual model that contains objects such as entities, attributes, and key groups.

Physical

A database-specific model that contains objects such as tables, columns, and data

types.

Physical Moded
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A single model that includes both the logical and physical models.
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Entities

Entities

An entity is a logical object that represents a person, place, or thing about which an organ-
ization maintains information.

In the following diagram, the logical data model has the following entities:

CUSTOMER

EMPLOYEE
" MOVIE
MOVIE COPY
MOVIE RENTAL RECORD
PAYMENT
STORE

CUSTQUIER
HCAE COPY

-

. Ll
| b e g
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Tables

Tables

In the logical model, an entity usually corresponds to a table in the physical model. In the
physical model, a graphic box represents a table in which data is stored in the database.

Customear Table in ERwin |
CUSTOMER
cgst ey E
ridmiE
S diess

Custormer Table im the database

cust_no | name | address J/"

1234 |Brown |5 Main
X345 |Jones |[129
FeL [Smith |77
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Types of Entities/Tables

Types of Entities/Tables

Two types of entities/tables can be drawn in a data model:

Independent Entity

An entity whose instances can be uniquely identified without determining its rela-
tionship to another entity. It is represented as a box with square corners.

Dependent Entity

An entity whose instances cannot be uniquely identified without determining its rela-
tionship to another entity or entities. It is represented as a box with rounded corners.
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When you add an entity, the entity type is determined based on the relationship in which it
is involved. For example, when you initially place an entity in a model, it is represented as an
independent entity. When you connect the entity to another entity using a relationship, it is
determined if the entity is independent or dependent based on the relationship type.
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Attributes and Columns

Attributes and Columns

After you have discovered the people, places, and events that define the entities in your
model, you can begin to define the attributes for each entity.

Attributes collect information about an entity and columns collect information about a
table. Logical attributes usually correspond to physical columns in a table.

For example, after you create the CUSTOMER entity, you can begin to define the individual
pieces of information you want to track for each customer, including Name, Address, and
Phone Number. In the logical model, each of these pieces of information is saved as an
attribute of the CUSTOMER entity. In the physical model, attributes equate to columns in a
table.

customer number)

name
addresg An attribut e
phone corresponds to a

: columen in a Tahle
credit carnd

cradit card exp
status code

{cust_no ) name | addrass J

5 Main

A row of data is inserted in a table when a record is added to the database directly or
through an application.

After you create an entity or table, you can add attributes and columns, respectively.
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Attributes and Columns

Many easy methods for creating and modifying the properties of these objects are provided.
The most basic method is to add the name directly in the Diagram Window. You can also use
a domain to add attributes and columns.
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Primary Key and Non-Keys

Primary Key and Non-Keys

Entities and tables are drawn as a box with a horizontal line near the top of the box.

The area above the horizontal line is known as the key area because that is where the
entity's primary key resides. The primary key can be comprised of one or more attributes
that uniquely identify the entity.

The area below the horizontal line is known as the non-key area because that is where all

other attributes reside.

CLUSTOMER
customer number & Primany Key

narme
address

phone HNon-K
credit card ' ¥
credit card exp

slatus code

A foreign key may appear in either the primary key or the non-key area of an entity or
table. For more information about foreign keys, see Foreign Key.

erwin DM Navigator Edition User Guide

29



Relationships

Relationships

An important object in a data model is the relationship, which is represented by the solid or

dashed line that connects two entities or two tables. A relationship line connects a parent

and a child entity or table. Usually, a symbol appears at the child-end of the relationship

line. The symbol changes based on the diagram notation that you select.

Child-end of
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Types of Relationships

Types of Relationships

Relationships are important because the type of relationship determines how a primary key
of the parent entity or table migrates to the child entity or table as a foreign key. There are
two basic types of relationships:

Identifying Relationship

An identifying relationship is represented by a solid line and through it the primary
key of the parent migrates to the primary key area of the child entity or table.

Non-ldentifying Relationship

A non-identifying relationship is represented by a dashed line and through it the
primary key of the parent migrates to the non-key area of the child entity or table.

In an identifying relationship, the foreign key migrates above the line and becomes part of
the primary key of the child entity (see Foreign Key for more information). In a non-identi-
fying relationship, the foreign key migrates below the line and becomes a non-key attribute
in the child entity. A dashed line represents a non-identifying relationship.
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credit oard relationship mgrated
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Types of Relationships

If you want a non-key to migrate instead of the primary key, you can use the alternate key
migration option. For more information, see the online help.

erwin DM Navigator Edition User Guide |32



Other Relationship Types

Other Relationship Types

In addition to identifying and non-identifying relationships, you can also create these rela-

tionships:

CUSTOMER

| ORCER

Identifying relationship

CUSTOMER

E PATMENT

L_ E
Non-identifying rela-
tionship
EMPLOTEE

—+

Recursive relationship

DROER

FRODUCT
l

tionship

Many-to-many rela-
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Other Relationship Types

PAYMENT

CHECK CREDIT

Supertype/Subtype relationship
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Foreign Key

Foreign Key

When you create a relationship between entities, the primary key attributes of the parent
entity are automatically migrated to the child entity. The designator (FK) indicates the name
of the migrated key attribute, also known as a foreign key. This migration occurs auto-
matically in the physical model.

MOWIE RENTAL RECORD
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= nisl ks
o e chape

If the foreign key attribute has the same name as an owned attribute in the child entity, the
two instances are automatically unified into one attribute because it assumes that they are
the same attribute. The process of combining or unifying identical attributes in an entity is
called unification.

The foreign keys display in the model by default, designated by (FK). If you do not see this
designation, open the Diagram Editor (click Diagrams in the Diagram menu), and do the
following depending on whether you are working in a logical or physical model:

Logical model

Click the Entity tab, and ensure the options Display Logical Foreign Key (FK) Designator and
Display Migrated Attributes are selected.

Physical model

Click the Table tab, and ensure the option Display Physical Foreign Key (FK) Designator is
selected.
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Foreign Key
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Workplace Panes

Workplace Panes

Each of the following panes within the workplace is dockable and floatable, and where
applicable, contains its own toolbar:

" Explorer Pane (Model Explorer)
" Action Log Pane

" Advisories Pane

" Overview Pane

" Bulk Editor Pane

Each pane provides two options for how it displays:

i Auto Hide

Activates auto hide. The pane becomes a tab in the application. When auto hide is
activated, the pane is not visible in the workplace unless you hover your mouse over
the tab of the hidden pane. When you do this, the pane is temporarily restored to
allow you to work in the pane. When your mouse leaves the pane, it becomes auto-
hidden once again. To turn off auto hide, mouse over the tab to restore the pane, and
then click the pushpine= .

w Close

Closes the pane. To open the pane again, select the appropriate pane on the View,
Windows menu.

Pane grouping functionality is provided to assist you with arranging panes in the workplace.
Dockable panes can dock to other dockable panes so that they combine to create multiple
tabs in a single dockable pane, or pane group. Similarly, tabs on dockable panes can be
undocked / ungrouped and floated or docked to the top level frame window as individual
dockable panes. When two or more panes are docked together in a tab group, the tab selec-
tion interface displays at the bottom. When panes are not grouped, the tab selection inter-
face is not shown. When tabs are grouped, the title bar on top of the pane changes to the
title bar of the currently active tab.
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Workplace Panes

Model Explorer
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To dock panes together into a pane group, simply drag and drop one pane over another. To
undock, drag the tab of the pane you want to undock and drop it in the workplace.
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Overview of Model Explorer

Overview of Model Explorer

The Model Explorer provides an organized, hierarchical, text-based view of your data model

and its contents. It provides an easy method for creating objects. The Model Explorer lets

you create, display, navigate, and modify your model.

The Model Explorer has two panes, Model and Subject Area, as shown in the following illus-

tration:

Model Explorer

1%

<l H O 8BS

=4 Model_1
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----- @ Datatype Standards
----- ¥ Default Values
- 5% Domains

----- E’ Entties

7|} ER Diagrams

----- B2 Model Sources

----- @ Maming Standards
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----- Eﬁ' Subject Areas
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----- Validation Rules

=+

D Model [[B Subject Area

All the objects in your model are listed in the Model Explorer, but display differently based

on the active pane.
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Overview of Model Explorer

" The Model pane includes every object in your model including subject areas and
domains. The Model pane is the default view.

" The Subject Areas pane displays model objects that are sorted by subject area.

When you change an object in the Model Explorer, the graphical view of the model is imme-
diately updated with the same change. For example, if you rename a table in the Model
Explorer, the new table name appears in the Diagram Window and the relevant editors. Sim-
ilarly, if you change an object the diagram or in an editor, you immediately see the change

in the Model Explorer.

Just as you can create an entity, a table, or a relationship using the Toolbox, you can create
an object in the Model Explorer. To create an object, right-click on any object and click New.
You can drag some objects from the Model Explorer onto the Diagram Window to create an
object. For example, you can drag a domain onto an attribute or a column.

Using the Model Explorer, you can open the property editor for an object in two ways:
) Right-click the object and click Properties.

" Select the object and click the Property Editor icon in the Model Explorer toolbar.
I For bulk editing of object properties, you can use the Bulk Editor.
The Model Explorer and the data model are always in sync, regardless of the method you

choose to add or edit an object.

You can also move, copy, and delete most objects in the Model Explorer, same as you do in
a Diagram window.

After you move, copy, or delete an object, all the instances in the model that reference the
object are automatically updated.
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Model View

The primary purpose of the Model view is model exploration and to function as an altern-
ative launching point for object and property editors. The Model view lists all the object
types that appear in the current data model. The object types that are displayed here are
based on the model type and the target server.

For example, if the model type is Logical, the Model Explorer does not include physical
objects such as a view. Similarly, if the model type is Physical, the Model Explorer does not
include logical objects. If the target server is Oracle, then objects specific to Oracle such as
Clusters are displayed.

The following types of objects are not displayed in the Model Explorer:

" Minor objects that are included in the parent object editor. For example, a Valid Value
object is created, deleted, and edited by the Validation Rule Editor.

" An object that represents configuration information, created for an internal process,
and is not actual model data. For example, as a Complete Compare Option Set.
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Subject Area View

The Subject Area view provides a filtered view of the model and minimizes unnecessary tree
information. This view displays the model objects that are sorted by Subject Area. You can
create Subject Areas to divide the model into smaller manageable parts, which is helpful
when you work with large models.

The following illustration shows the Subject Area view:
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Select a Subject Area to view the objects that are included in it. For example, in the previous
illustration you see that the tables are categorized as tables, and views are categorized as
views. This view is different from the display of the Subject Area objects in the Model view.
Only those relationships are included here that are visible on the diagram and have both the
endpoints present in the Subject Area.
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The global objects that do not relate to the selected Subject Area, such as Subject Area
objects or model source objects are not displayed.
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The Model Explorer Toolbar

The Model Explorer Toolbar

The Model Explorer contains a toolbar to help you navigate your object editing, launch prop-
erty editors, delete objects, and invoke online help.

A H 0T S

erwin DM Navigator Edition User Guide |44



The erwin Toolbox

The erwin Toolbox

The toolbox is the primary set of tools for drawing and editing a data model. In the Toolbox,
use the Select tool to move objects and resize entity and table boxes. The cursor changes
shape for each task so that you know what action is performed.

WEHEOS M e,

You have the option to resize any box to meet your presentation requirements. For

example, you may want all of the entity, table, or view boxes to be uniform in size, or
emphasize one or two boxes by making them larger than the others.

The toolbox changes based on the model type (logical or physical) and the notation (IDEF1X,
IE, or DM).

For more information about the IDEF1X, IE, and DM notation, see the online help.

erwin DM Navigator Edition User Guide |45



Alignment Toolbar

Alignment Toolbar

The appearance of your data model is important to you and the others who use it. There are
many features that help you enhance the appearance of your model. You may already be
familiar with some of the automatic layout features that help you arrange objects in your
diagram.

A toolbar is provided that can help you quickly align the object boxes along the top, bottom,
or sides of the boxes.

The tools on the Alignment Toolbar help you quickly arrange model objects.
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Drawing Toolbar

You can enhance a model using the Drawing toolbar to create different drawing objects. The
tools work like many other popular point-and-click drawing applications. Just click a tool,
click in the diagram window, and drag the mouse until the object is the right size.
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The Go to Diagram Option

The Go to Diagram Option

When you have several hundreds of objects in a model, it might be difficult to locate a spe-
cific object. To locate an object in a diagram quickly, right-click the object in the Model
Explorer and click Go To Diagram. The object is selected in the Diagram window.
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Object Properties
Using the Model Explorer, you can open the property editor for an object two ways:
" Right-click the object and click Properties.

" Select the object and click the Property Editor icon in the Model Explorer toolbar.
I For bulk editing of object properties, you can use the Bulk Editor.

Regardless of the method you choose to add or edit an object or its properties, the Model
Explorer and the data model are always in sync.

Object properties also migrate through relationship lines. In other words, objects can
inherit properties from their parent objects.
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Object Moving, Copying, and Deleting

Just as you can move, copy, and delete attributes and columns in the Diagram Window, you
can also move, copy, and delete most objects in the Model Explorer.

After you move, copy, or delete an object, all the instances in the model that reference that
object are automatically updated.
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Action Log

The Action Log works in real time so you can make modeling decisions during your current
session rather than having to wait until you save the model to review changes. The Action
Log lets you determine the best way to work.

If the Action Log pane does not display in the workplace, click Action Log Pane on the
View, Windows menu.

As you work on the graphical view of a model in the Diagram Window, you can view the
transaction information in the Action Log. As you make changes to your model, the Action
Log is updated in real time. For example, if you create an entity in your model, the Action
Log reflects this change.

Changes are only viewable in the Action Log during your current modeling session. Each new
session begins with an empty Action Log. When you close the model, the Action Log clears.
Before closing your model, you can generate a report that lets you view all the changes
made during the current session.

The type of objects that appear in the Action Log is based on the display mode you are
using. If you are working with a logical model, then only logical objects appear. If you are
working with a physical model, then only physical objects appear.

The Action Log lets you search for every transaction and filter by type of change so that you
can easily find a specific transaction or a set of transactions. This feature is particularly help-
ful when working with large models.
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Action Log Panes

The Action Log has two panes, Details and Summary, with corresponding tabs. Select the
Details tab to see every change (transaction) made to a model, or select the Summary tab to
see the net result of changes made to a model.

A transaction is a single unit of work that is not divisible into smaller components. The
Action Log lets you navigate through the transaction tree using the Details pane or the
Summary pane.

erwin DM Navigator Edition User Guide |52



Details Pane

Details Pane

The Details pane shows all the changes you make to a model during the current session. The
Details pane is the default view when you launch the program. Changes appear in the
Details pane with the most recent transaction at the top of the tree, and the first trans-
action at the bottom of the tree. You can either expand or collapse each transaction.

The toolbar on the Details pane lets you reverse a transaction, find a transaction, view prop-
erty details, and undo and redo to a selected transaction while working in the current ses-

sion.
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Summary Pane

The Summary pane displays the net result of changes made to the model during the current
session. It provides a filtered view of all the actions you perform on the model during the
current session so that unnecessary tree information is minimized, which is especially help-
ful when you are working with large models.

The Session Summary node is the top-level node in the tree. All changes you make to the
model at the object level and property level appear below the Session Summary node in the
tree.
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The Summary pane is similar to the Details pane except for the following differences:

" While the top-level nodes in the Details pane are transactions, the Summary pane has
only one top-level node with changes appearing below it.

" The Extended Find and Filter feature is only available in the Summary pane.

" The Reverse, Undo to Selected Transaction, and Redo to Selected Transaction options
are not available in the Summary pane.
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Action Log Tasks

In addition to viewing the detail and summary transactions, the Action Log provides a range
of useful features that help you easily perform the following actions:

Locate text within a transaction, object, or property using the Find feature.

Use the Extended Find and Filter feature to locate, filter, and report on the results of
your search. This feature is available only in the Summary pane.

View old and new details relating to a property transaction using the Property Details
feature.

Reverse a transaction. This feature is available only in the Details pane.

Undo a group of sequential transactions. This feature is available only in the Details
pane.

Redo a group of sequential transactions. This feature is available only in the Details
pane.
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Locate Text Using the Find Feature

The Action Log Find dialog lets you search for specific text at the transaction level, object
level, or property level. This option is available on both the Details and Summary panes.

Find x|

Find what: | | Fird Mexk

[ Imatch case Search Cancel

[1ratch whole waord [ Transaction

[ search up Object

By default, the search includes the entire tree, starting from the current selection point. If
there is no current selection point, then the top of the tree is used as the starting point. If
the search did not start at the top node, the search wraps to the beginning of the tree after
reaching the end.

To locate text using the Find feature

1. Click Find on the Action Log toolbar.
The Find dialog opens.
2. Enter the text you want to search for in the Find what text box.
3. (Optional) Select the Transaction, Object, or Property check box to narrow your
search.
Since there are no transaction nodes in the Summary pane, the Transaction search
option is not applicable to that pane.
4. (Optional) Select one of the following check boxes to refine your search:

Match case
Specifies to search on case-sensitive text.
Match whole word

Specifies to search for the entire text string.
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Search up

Specifies to search for the text from the bottom up.

5. Click Find Next.
The next occurrence of text displays.
6. Click Cancel when you are finished searching.

The Find dialog closes.
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Use Extended Find and Filter

The Extended Find and Filter feature lets you set find and filter criteria and view property
changes. This feature is available only on the Summary pane of the Action Log. To open the
Extended Find and Filter dialog, click the Extended Find/Filter button on Action Log toolbar.

When the Extended Find and Filter dialog opens, it provides a snapshot of the Summary
pane and lets you filter the information that displays so you can easily find the information

you want.

To use the Extended Find and Filter option

1.

Click Extended Find and Filter on the Action Log toolbar in the Summary pane.
The Extended Find and Filter dialog opens.

Click Find on the toolbar.

The Find Criteria dialog opens.

Select the Properties, Categories, and Classes that you want to find. These options let
you filter the information that displays.

Click Find to start the search.
The Find Criteria dialog closes.

Click the Find Next button on the Extended Find and Filter toolbar to find the next
occurrence of the search item.

Click Close.

The Extended Find and Filter dialog closes.
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Undo a Transaction

To undo the last change that you made to your model, use the Undo button on the Toolbar
or click Undo on the Edit menu. This feature undoes one change at a time, and is reflected in

the Action Log by a dimmed transaction.
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Redo a Transaction

To redo a transaction that you made to your model, use the Redo button on the Toolbar or
click Redo on the Edit menu. This feature restores one change at a time.
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Reverse a Transaction

The Reverse feature in the Action Log lets you perform an opposite action on most entries
that appear during the current modeling session. When you reverse a transaction, the
model reflects the changes made to the Action Log. This feature is only available on the
Details pane, and does not sequentially reverse actions.

For example, if the Details pane displays Created [Entity] object:'Entity_5'(id=5) and you
select the transaction and click Reverse, a Delete on Entity_5 is implied.

Depending on how complex your model is, when using the Reverse feature, an attempt is
made to restore the model to its best state. Use the Activity Log to determine whether your
transaction has been properly reversed.

Important! Reverse applies to the entire transaction even if you select only the object or
property level node.

To reverse a transaction
1. Click the Details tab in the Action Log.

2. Select a node in the tree containing an action that you want to reverse, and click
Reverse on the Action Log toolbar.

The opposite action occurs.
You cannot perform a reverse action on the topmost node in the tree. Use the Undo

feature instead. You also cannot reverse the transaction in which the model was cre-
ated - this transaction is marked with the pin icon.
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Undo and Redo to Selected Transaction

The Undo to Selected Transaction feature in the Action Log lets you undo an entire range, or
a sequential group, of transactions at the same time. Conversely, the Redo to Selected Trans-
action feature lets you restore a sequential group of transactions.

To undo to a selected transaction or redo to a selected transaction, you must be in the
Details pane in the Action Log.

As you create transactions on your model, each one moves the previous transaction down
the tree in the Action Log, with the first transaction always appearing at the bottom of the
tree. When you want to undo a range of consecutive transactions, the transactions above,
including the one you select are undone. To redo a range of transactions, the transactions
below, including the one you select are redone.

Important! After performing an undo to selected transaction, you will not be able to redo
these transactions once you perform a new action, since the new action clears the redo
stack.
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Undo/Reverse Comparison

You can undo or reverse changes you make to your model. The following table summarizes

the differences between the three available features, and suggests when it is appropriate to

use each one:

Feature

Undo

Reverse

Undo to selec-
ted trans-
action/ Undo
to this point

Toolbar

Standard
toolbar

Action Log
toolbar

Action Log
toolbar

When to Use

When you want to undo the last, single action you took.

This feature is similar to the Microsoft Windows undo fea-
ture; it lets you undo the last action taken.

When you want to perform an opposite action that is not
the last action you took in the current modeling session.

This feature applies to the entire transaction even if you
select only the object or property level node.

You can use the Undo button to undo a reverse action
made in error. For some transactions, you can also reverse
a reverse action.

You cannot perform a sequential reverse using this fea-
ture.

When you want to undo sequential transactions performed
in the current modeling session.

This feature lets you undo a range, or sequential grouping,
of transactions at one time.

You can perform a redo to selected transaction to the
same group of transactions or a smaller set of the con-
secutive transactions in the group. You can use this feature
at any time during the current modeling session.
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Generate a Session Activity Report

You can generate a Session Activity report to view a list of objects created and deleted, and
objects and properties that were changed.

To generate a Session Activity report
1. Click Pinned Reports, Session Activity.rpt on the Tools menu.
The report is generated and opens in the erwin Report Viewer.
2. (Optional) Export or print the report.

3. Click Exit on the File menu to close erwin Report Viewer and return to the diagram.
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Advisories Pane

The Advisories pane is a dockable, floatable window in the main workplace. This pane auto-
matically appears when you start the program.

fdvisaries

OAE<$

Create Entity

Advisaries | Action Log

The Advisories pane displays messages associated with actions you perform when working
with your model. Each message on this pane shows you when a change or edit you make to
a property is valid and alerts you when the action you have taken violates a modeling rule.
When alerted, you can immediately correct your action instead of searching for the trans-
action at some later time.

In addition to viewing the valid and violation messages, you can obtain details about a spe-
cific action that generated the message. For example, if you set a property, the Advisories
pane shows a €Set Property® message. Click the Details button on the Advisories toolbar to
display the Advisories Details dialog and get more information about the property. This fea-
ture is particularly useful when you are working with a large model and you need cla-
rification about that particular action.

erwin DM Navigator Edition User Guide | 65



Overview Pane

Overview Pane

The Overview pane provides a smaller, targeted view of the current diagram in the work-
place and changes dynamically as you make changes to the current diagram. You can also
use the Overview pane to change the view of the current diagram in the workplace by
adjusting the overview area or zooming in or out.
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Bulk Editor Pane

The Bulk Editor is provided so you can edit a small set of properties over a large number of
objects. Changes and updates are immediately committed as you make them, field by field.

The Bulk Editor includes a Bulk Editor Wizard for specifying the data to edit and saving those
selections as option sets for use with the model in a future editing session, or shared by all
models. Because the Bulk Editor is empty the first time you invoke it in a session, the Bulk
Editor Wizard is automatically opened so you can make your object and property type selec-
tions. Thereafter, the Bulk Editor is displayed as a modeless grid on a tab page on the
erwin® Data Modeler main window that shows your selected object instances as rows and
your selected properties as columns. You can resize, rearrange, or float the Bulk Editor
within the erwin® Data Modeler application. Objects are identified by a fully qualified name
in the Name column, which is non-editable. A read-only Type column is next to the Name
column that displays the object type. You can click the £% button on the Bulk Editor toolbar
at any time to open the Bulk Editor Wizard to change the object instances and properties
that appear in the Bulk Editor.
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During a session, opening the Bulk Editor or the Bulk Editor Wizard displays the same set-
tings and data as the last time it was shown. These settings are stored independently for
each model. This is necessary since different models can have different DBMS targets and
contents, so selections of object types, properties, and object instances can be different
across models. The configuration settings are stored in the registry, so each user retains
their own Bulk Editor settings.
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Open an Existing Model

Open an existing model to perform data modeling activities.
To open an existing model
1. Click Open on the File menu.
The Open File dialog opens.
2. Select the drive, folder, and model that you want to open and click Open.

The model opens.
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Open a Model Saved in XML Format (XML Import)

You can use XML format to import a model file previously saved in XML format. XML format
replaces the text-based ERX format used in earlier versions of this product. XML format
provides structured markup of model metadata according to elements that are defined in
the XML Schema.

To import a file in XML format
1. Click Open on the File menu.
The Open File dialog opens.

2. Select XML Files (*.xml) from the Files of type dropdown, select the directory and XML
file name that you want to open, and click Open.

The File Open dialog opens.
3. Select to validate the XML file against the schema prior to opening the file.
The file is verified. You can view the progress of the XML Import in the progress dia-

log.

I Any errors that occur during the XML Import process are displayed in the Advisories Pane.
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Connect to Mart

If you are using erwin Data Modeler Workgroup Edition, you connect to the Mart to access
models and perform administrative functions.

The way erwin Data Modeler connects to the Mart has been redesigned now. In the pre-
vious versions, erwin Data Modeler would connect to the Mart (database) server directly.
Now, erwin Data Modeler connects to the Mart through a web server. You can connect mul-
tiple instances of erwin DM to the Mart from your computer.

From erwin Data Modeler (DM) and erwin Mart Portal (MS) 2019R1 onward, while con-
necting to the erwin MS from erwin DM, version validation has been implemented as fol-
lows:

1. Connecting from erwin DM 2019R1 to erwin MS lower than 2019R1 is not allowed.
2. Connecting from erwin DM lower than 2019R1 to erwin MS 2019R1 is not allowed.

At the time of logging on to Mart, you must provide the details about the web server and
the Mart.

Follow these steps:

1. Click =] on the toolbar, or on the ribbon, click Mart > Connect.
The Connect to Mart dialog opens.

2. Complete the following fields:

Server Name

Defines the name of the web server where you have installed the Mart.
Port

Specifies the port number to access the web server.
Use SSL

Specifies that you want to connect to the Mart through a secured connection.
SSL lets you access the Mart through a secured connection. This check box is
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enabled only if you have configured SSL on your web server. For more inform-
ation about configuring SSL, see the Implementation Guide (Workgroup Edi-
tion).

Application Name
Defines the application name of the Mart that you want to connect to.
Default: MartServer

Authentication

Specifies the type of authentication you want to use. You can use a user name
that is authenticated either by the Mart Portal application or by Windows.

User Name

Defines the name of the user that has access to the Mart. If you are using a Win-
dows-authenticated user name, enter it in the <domain name>/<user name>
format.

A local Windows user who does not belong to a domain or who is not part of
an Active Directory cannot log in to the Mart as a Windows user.

Password
Defines the password of the user.
A password should fulfill the following criteria:
* Contains at least 1 lowercase character
* Contains at least 1 uppercase character
* Contains at least 1 number
* Is minimum 6 characters in length

* Is maximum 130 characters in length

Apart from the above criteria, special characters are optional.
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Also, if you enter an incorrect password five consecutive times, your account
will be locked for five minutes (300 seconds) by default.
You can change the time for which the account stays locked as follows:

From Windows Start menu, click All Programs, erwin, Mart Portal 12.5, Con-
figure MartServer.

The erwin Mart Configuration dialog appears.

On the Mart Portal tab, edit the value of the Account Lockout Duration
(Seconds) field to an appropriate value. At the most, you can set it to 30 days
(2592000 seconds).

3. Click Connect.

If you have selected Use SSL and the security certificate is installed, you are connected
to the Mart.

After you connect to the Mart, if you click Connect to Model Manager again, a dia-
log opens seeking your permission to disconnect from the Mart.

If your security certificate is not installed, the message The certificate authority is

invalid or incorrect appears. You must install the security certificate to proceed.

a.

Click OK on the message.

The SSL Certificate Install dialog appears.
Click Install.

The Certificate dialog appears.

Click Install Certificate.

The Certificate Import Wizard dialog appears.
Click Next.

Click the Place all certificates in the following store option button and click
Browse.

In the Select Certificate Store dialog, select Trusted Root Certification Author-
ities and click OK.
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g. Click Finish.

The security certificate is installed and you are connected to the Mart.
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Open a Model from the Mart

You can select the lock option when you open a model. Model locking helps to secure mod-
els and manage how changes are saved to the mart. However, the options available to you
depend upon your security profile and whether another user has already locked the model.
Contact your administrator if you must change your security profile.

When you lock a model, you also have the option to retain the lock after you end your ses-
sion. For example, you can retain the model lock when you work on a model offline to pre-
vent other users from saving changes to the model.

To open a model from the mart
1. Click Mart, Open on the File menu.

The Open dialog opens. The lock icons in the Open dialog indicate the lock status of a
model.

" A yellow open lock indicates a model is open by any user.
" Aclosed green lock indicates a model is locked by you.
" Aclosed red lock indicates a model is locked by another user.
2. Select a Library from the list of libraries in the left pane, a Model Name in the right
pane, and one of the following locking options for the model:
Unlocked

You can open a model in Unlocked mode if you have permission to update and
save a model. This option lets several users open and edit the same model.
Users can save their changes to the master model in the mart on a first-come,
first-served basis. As a result, you may have to reconcile any differences with
the changes when you save the model to the mart.

Locked

If you have permission to update and save a model, you can select the Locked
option. The model is locked exclusively for your own use and other users can
not save changes to the master copy in the mart.
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Read-only

You can open a model in Read-only mode if you do not have permission to
update and save a model or if someone has the model opened in locked mode.
When you select this option, you can only view the model and save it locally as
a .erwin file (erwin Data Modeler). You cannot save your model changes back to
the mart.

3. Click Open.

The model opens in a separate model window.
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Customizing the Appearance of Data Models

There are many features that you can use to change the way a model displays on the screen
and how it appears when you print it. For example, three different notations are supported:
ICAM Definition Method 1 Extended (IDEF1X), Information Engineering (IE), and DImen-
sional notation (DM). To change the notation, choose Model, Model Properties, Notation on
the toolbar.

You can also change the level of information that displays. For example, in the logical model,
you can choose to display entity names only or the entity names, attribute names, and the
key group designators. Similarly, in the physical model, you can display or hide properties
such as column or datatype.
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Display Levels

Two sets of display levels are provided, one for the logical model and one for the physical
model.

These display levels are useful for showing different types of information in a data model,
particularly when different people and groups use the data model for their specific job in

the development process.
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Logical Display Levels

The Logical Display levels are as follows:

Entity

Displays the name of each entity in a data model inside an entity box. No other inform-
ation displays for the entity.

Attribute

Displays the attributes for each entity in a data model, with the primary key attributes
above the line and the non-key attributes below the line in an entity box.

Primary Key

Displays the primary key attributes (those found above the line in an entity box) for
each entity in a data model. The attributes below the line are hidden, but display
when you switch back to the Attribute Display Level and you can also see them in the
Attribute Editor.

Keys

Displays primary key attributes above the line and does not display any non-key attrib-
utes below the line in an entity box. Entity boxes have two attribute boxes; the upper
populated with the PK attributes and the lower populated with the attributes belong-
ing to all key types except PK.

Definition
Displays the definition for each entity in a data model.
Icon

Displays the bitmap, if you have assigned one to the entity. You can assign a different
bitmap to each entity in the Icon tab of the Entity Editor.

The following diagram uses the same entities and illustrates each of the logical display
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Physical Display Levels

The Physical Display levels are as follows:

Table/Node/Collection/Record/Document/JSON Object

Based on the model's target database, displays the name of each table, node, col-
lection, record, document, or JSON object in the data model. No other information is
displayed for the table.

Column/Field

Based on the model's target database, displays the columns or fields for each table in
a data model, with the primary key columns above the line and the non-key columns
below the line in a box.

Primary Key

Displays the primary key columns (those found above the line in a table box) for each
table in a data model. The columns below the line are hidden, but display when you
switch back to the Column Display Level and you can also see them in the Table
Column Editor.

Keys

Displays primary key columns above the line and does not display any non-key
columns below the line in a table box. Table boxes have two column boxes; the upper
populated with the PK columns and the lower populated with the columns belonging
to all key types except PK.

Graph

For graph databases (ArangoDB and Neod4j), displays the model in the graph-like rep-
resentation.

Comment
Displays the comment for each table in a data model.

Icon
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Displays the bitmap, if you have assigned one to the table. You can assign a different
bitmap to each entity in the Icon tab of the Table Editor.

Physical Order

Displays the order in which each column appears in the corresponding table.

The following diagram uses the same tables and illustrates each of the physical display

levels:
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Display Options
You are also provided with display options for entities and their relationships. These options
are useful for showing different types of information in the logical model:

" Entity display options
' Relationship display options

Use the shortcut menu to set these options.
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Entity or Table Display Options
You can use the entity or table display options to view information about entities and tables

in a data model.

Zoom }
Display Level }

Table Display 2 v Column Datatype
Database View Display ¥ Column Domain
Relationship Display b Bl Option

, , Primary Key Designator
RN v Foreign Key Designatar (F)
v Show Shadaws v Alernate ey Designatar (AK)
Diefaul Fots & Colors. . Table Crwner
TetleOmer using User

Harden Physical Names
UnHarden Physical Names v Ungenerated Tables

The Format menu changes based on whether the currently displayed model is physical or

logical.
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Relationship Display Option

In both the logical and physical data model, you can use the display options to view the rela-
tionship properties.

£0am }
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Relationship Display MRS

| | Cardnalty

P Referential Integrity
v Shiow Shadaws v Subtype Discriminator

Diefaulk Fonts & Colors. .

Harden Logical Names
| InHardzn Lagical Hames

erwin DM Navigator Edition User Guide | 84



Font and Color Change for Individual Objects

Font and Color Change for Individual Objects

You can also change the color or font of individual objects in your diagram in the following
ways:

" Select the object, then click an option in the Font and Color Toolbar

" Select the object, then right-click and select Object Font & Color on the shortcut

menu.
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Customize Object Fonts and Colors

When you add an object to a diagram, the default font, color, fill, and line options for that
object type is automatically assigned. Use the Theme Editor to assign the default display
theme to objects, or create your own theme. Use the following procedure to customize the
settings for the objects you create.

To customize object fonts and colors
1. Click Themes on the View menu.
The Theme Editor opens.

2. Navigate the tabs on the dialog to set default color and font information. You can also
specify font and color properties for all model objects, new objects you create, or cur-
rent objects in the model.

The tabs that appear vary depending on whether you are working with a logical,
physical, or logical/physical model.

Click OK.

The new default settings are saved and the dialog closes.
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Changing the Diagram Window Maghnification Level

You can use the following Zoom options, which are available on the erwin® Data Modeler
Toolbar and on the View Menu, to view a model at different magnification levels.
Zoom Out

Decreases the magnification of your model in the diagram window by an offset of 10.
Zoom In

Increases the magnification of your model in the diagram window by an offset of 10.
Zoom Normal

Resets the magnification level to 100 percent.
Fit Model

Reduces the magnification level to fit the entire model in the diagram window.
Fit Selection

Magnifies a specific area of the model to fit within the diagram window. Drag the mag-
nifying glass cursor around the portion of the diagram window that you want to view
and the appropriate Zoom level is applied to the model and fills the diagram window
with the selected portion.

Display magnification is managed independently from print magnification. When
you print the diagram window, the zoom display settings are ignored and allows
you to change the scale to show more or less of the diagram window on each page.

The minimum screen resolution supported is 1024 x 768. Also, ensure that your dis-
play settings are always set to 100%. If your screen resolution is less than the min-
imum supported, some portions of the screen will not be visible. If you are working
in an editor and you cannot see the Close or Cancel buttons, you can hit the Enter
key to close and the Esc key to cancel.
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Print a Data Model

You can print your model to your default printer. Before you print, you can customize
options for the printed output.

To print a model
1. Click Print on the File menu.
The Print dialog opens.
2. Select from the following options on the Print dialog:
Printer
Specifies the destination printer. Select a printer name from the drop-down menu.

Select Print to file to save the print output to a file instead of a printer.

The Microsoft Print to PDF option works well the first time you use the Print option.
For every subsequent usage of Microsoft Print to PDF option, first set the Printer to
another option and click Print. This causes the Microsoft Print to PDF drivers to
reset. Thus, allowing you to print to a PDF file.

Print range

Print all pages of the model, or a range of pages.

Copies

Prints one or more copies of each selected page. You can also select to collate the cop-
ies.

Print what

Print the current diagram (the open diagram from which you opened the print dialog),
or current selection or all diagrams currently open.

Print order

Specifies the direction taken for the print output. For example, if you have a large
model that prints on multiple pages, you can select "Over, then down" to create a
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Print a Data Model

printout with a horizontal orientation. Or, select "Down, then over" to create a prin-
tout with a vertical orientation.
Fit to page

Specifies to scale the entire diagram so that it fits on a single page for the selec-

ted printer and paper size. Select the check box to enable this option.

If you select this option and have selected more than one diagram to print,
each diagram prints on a separate page.

3. Click Preview to view your output page by page, before starting the print job.

The page preview that is displayed takes into account the page margins that you set
in the Page Setup Editor. This means that what you see in the Preview page is what
will be printed.

Click Zoom In to zoom the diagram to the size of the paper. Click Zoom Out to zoom
the diagram to a size that can be fit in the Preview window.

To print immediately, click Print; otherwise click Close to go back to the diagram win-
dow.

4. Click Page Setup to customize print options such as page size, orientation, zoom, bor-
der, color, header, footer, and margin.
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Print Only What You Want

Print Only What You Want

You can use the mouse in the embedded Diagram Window in the Print dialog to perform the

following tasks:

Change the print scale
Drag a page grid line until your model fits in the grid pages exactly how you want the
model pages to print. You can also enter a value in the Print Scaling box.

Select specific pages for printing

Hold the CTRL key and click each page you want to print.
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Set Printer Options

You can set your printer options before you print the model.
To set printer options
1. Select Print Setup from the File menu.
The Print Setup dialog opens.

2. Accept the default printer, page orientation, paper size, and source settings or select
another option:

Select a printer from the printer Name list to select a different printer.

Click Portrait or Landscape to select a different page orientation.

Select a different paper size from the Size list to change the paper size.
Select a different paper source from the Source list to change the paper source.
Click the Properties button to open the Windows Document Properties dialog to

change graphic and print quality options.

Changing to landscape page orientation affects both the page grid and the printer fonts. If
you change the orientation for a model, you should adjust the objects and relationships in
your model for the new layout.
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Specify an Exact Print Scale Value

You can specify an exact print scale value in percentage.
To specify an exact print scale value
1. Select Print from the File menu.
The Print dialog opens.

2. Enter the print scale value that you want to apply to the objects in the model in the
Print Scaling (%) box, and click the TAB key.

" Enter avalue greater than 100 to enlarge the size of model objects.
" Enter a value less than 100 to reduce the size of model objects.

The size of the model immediately changes to reflect the print scale value that you
specify.

3. Click the Print button.

The model prints.

I To reset the model to 100% print scale, click the Reset Scale button.
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Add a Page Header or Footer

Add a Page Header or Footer

You can add a customized header or footer (or both) to all the pages when you print a
model. For example, you can print the Model Name, Subject Area Name, and Diagram Name
at the top of every page, and the page number, date, and time at the bottom of every page.

If you manually enter incremental information in the Header or Footer text box (for
example, page number, date, and so on), you cannot automatically update the text.

A toolbar & L1 [& [F is provided to make it easy for you to quickly add the fol-
lowing elements:

Current Page

Page Count
" File Name
Subject Area Name
Diagram Name
Time
Date
To add a page header or footer
1. Click Page Setup on the File menu.

The Page Setup Editor opens.

2. Click the Margins tab and work with the following options in the Header or Footer text
box:

" Click in the Header or Footer text box to specify in which area you want to
insert the customized text.

" Click the appropriate Header/Footer button to automatically insert information,
or use the keyboard to insert other information (for example, your name).

A preview of your selection displays beneath the text box.
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For example, if you selected file name and E/R diagram for the header, and date and
time for the footer, then the preview would be as follows:

General Mardins |

Header/Fooker

BRI E NN =

Header: I WoFile% - - %Displays

Test_Maodel -- ER_Diagram_4

Footer: |°.-1:.Date°f-:-, “aTime%a

5/4/2010, 4:39:39 PM

3. Work with the following related options in the editor:
" Indicate page margins (in inches) for the header or footer.

" Select the "Keep synchronized with Current Diagram" check box to associate
your selections with the current diagram.

" Click the Load from Diagram button to reset any changed settings to the set-
tings last saved to the diagram.

" Click the Save to Diagram button to save the current selections with the dia-
gram for future use.

4. Click Close to save your settings, or Cancel to cancel your selections.
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Page Margins
By default, the entire page is used for printing. Before you print, you can set separate page
margins (top, bottom, left, and right) for the current stored display.

When you click the Page Setup button in the Print Model dialog, the Page Setup dialog
opens at the Margins tab.
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Page Boundaries

By adjusting the page grid boundary lines, you can control how much information prints on
each page. The page grid boundary lines define the individual pages on which the model
objects will print. Using your mouse, you can drag the page grid lines in the Print Model dia-
log (within the thumbnail view) or in the diagram window, so more or fewer objects are prin-
ted on a particular page. To adjust the page grids from the diagram window, you must first
turn them on by choosing the Show Page Grid option from the Format menu. You can turn
off the page grids in the same way.

When you adjust the page boundary lines, the size of the page grid also determines the
print scale (the size of model objects and fonts). To enlarge the print scale, reduce the size
of the grid. To reduce the print scale, enlarge the size of the grid.

The paper size you select determines the dimensions of the page grid. To change the
paper size, click Print Setup from the File menu and then select a different paper size
option.

More information:

Specify an Exact Print Scale Value

erwin DM Navigator Edition User Guide |96



Set Print Margins

Set Print Margins

You can specify margins for all pages of your printed model.
To set print margins
1. Click Page Setup in the Print dialog.
The Page Setup dialog opens.
2. Click the Margins tab.
3. Enter a value between 0 and 1.5 inches for the left, right, top, and bottom of the
page.
4. Click OK.
The Page Setup dialog closes.

Margin measurements are considered when displaying the embedded Diagram Window in
the Print dialog.
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Reporting

This section contains the following topics

Data Model Reporting
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Data Model Reporting

Data Model Reporting

erwin Data Modeler Navigator Edition supports reporting with ODBC connectivity using the
Query Tool and Report Designer. You can also use the ODBC connectivity in erwin® Data
Modeler to create reports using any tool that supports an ODBC connection, such as
Microsoft Excel.reporting via the .
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The Query Tool

The Query Tool

The Query Tool provides an easy way to execute SQL SELECT queries against a model in
erwin Data Modeler (DM), a model in a mart, or against a database catalog. You can execute
a query against the objects and properties in the model, the metadata defining those
objects and properties, and the action log that records the changes that are made to your
model during the modeling session.

You can create new queries or paste text from another source (such as a *.sql file) into a
query.
You can save a query to a .*qry file for later execution. Query results can be saved to a *.csv

(comma-separated values) file.

Although the Query Tool provides a built-in query interface in erwin DM, you can also use
any third-party reporting tool that has ODBC capability to query erwin DM modeling data.

For more information on using ODBC data sources and sample queries, refer to the How to
Generate or View Reports and Useful Queries topics respectively.

More information:

Create a Query
Execute a Query

Execute a Query Against a Database

Execute a Query Against erwin ODBC
Save a Result Set to a CSV File
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Create a Query

Create a Query

You can create a query (SELECT statement) by entering text directly in the Query box, or by
pasting text from another source.

To create a query
1. On the ribbon, click the Tools tab.
2. Click Query Tool.
The Query Tool opens.

3. Enter your query in the Query box, or click the paste button on the toolbar to paste a
query from another source.

Your query is ready for execution. Use other features in the Query Tool to execute
and save the query.

Before you can execute a query you must be connected to erwin ODBC or to a database.
For sample queries and the details of schemas and tables, refer to the Useful Queries topic.

More information:

Execute a Query Against erwin ODBC

Execute a Query
Execute a Query Against a Database

Save a Query
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Open a Query

Open a Query

You can work with queries you saved to a *.qry file in a previous session, or you can option-
ally use a *.sql, or Microsoft SQL Server Query file.

To open a query
1. On the ribbon, click the Tools tab.

2. Click Query Tool.
The Query Tool opens.

3. Click the Open Query[@ icon on the toolbar.
The Open dialog opens.
4. Select a *.qry or *.sql file and click open.

The query text opens the Query box and is ready for execution.

I Before you can execute a query you must be connected to erwin ODBC or to a database.

More information:

Execute a Query Against erwin ODBC

Execute a Query Against a Database

Restrict Row Count in Query Results
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Save a Query

After you have created a new query or made changes to an existing query in the Query Tool,
you can save your query to a *.qry file for future use.

To save a query
1. Click the Save Query icon on the toolbar in the Query Tool.
The Save As dialog opens.
2. Select a file name and location for your query, then click Save.
Your query is saved and the Save As dialog closes.
3. Click Close.

The Query Tool closes.

More information:

The Query Tool
Execute a Query
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Execute a Query

Execute a Query

You can execute a new or saved query against the model or against a database catalog.
Use the following process to execute a query:

' Open the Query Tool from the Tools tab.

Create a new query or open an existing query (*.qry) file.

Connect to erwin ODBC or to a database.

(Optional) Select the option to restrict row count and enter a number to indicate the
number of rows by which to restrict results.

Click the Execute |+ icon on the toolbar.
After your query executes, the results display in the Results box. Use other features in the

Query Tool to save the query or save your result set.

I For sample queries and the details of schemas and tables, refer to the Useful Queries topic.

More information:

The Query Tool
Save a Result Set to a CSV File

Restrict Row Count in Query Results

erwin DM Navigator Edition User Guide | 104


Useful_Queries.html

Execute a Query Against a Database

Execute a Query Against a Database

You can run your query against a database catalog. To do this, you connect to the database
from the Query Tool and then execute your query.

Follow this process to run a query against a database:
' Open the Query Tool from the Tools tab.
Create a new query or open an existing query (*.qry or *.sql) file.
Click the Connect & icon on the toolbar.
Enter the database-specific connection criteria in the Connect dialog.

(Optional) Select the Restrict row count to check box and enter a number to limit the
number of rows returned.

Click the Execute icon on the toolbar.

After your query executes, the results display in the Results box. Use other features in the
Query Tool to save the query or save your result set.

You cannot be connected to erwin ODBC and a database at the same time in the Query
Tool. If you are connected to erwin ODBC, the (database) Connect icon is dimmed. Click
the Disconnect & icon on the toolbar to disconnect your erwin ODBC connection before
you attempt to connect to a database. Also, before you can make a database connection,
the appropriate database client software must be installed. See Database Connection
Overview for more information.
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Execute a Query Against erwin ODBC

To run a query against the current erwin Data Modeler model, you must first activate the
ODBC connection. The connection may already be active, if you selected the option to start
the ODBC driver on the Reporting tab in the Options dialog.

To connect to erwin ODBC
1. On the ribbon, click the Tools tab.
2. Click Query Tool.
The Query Tool opens.
3. Open a query (*.gry or *.sql) file or create a query.
Query text displays in the Query box and is ready for execution.
4. Click the Connect to erwin ODBC =a icon on the toolbar.
The ODBC connection is established. The Disconnect & icon becomes active. Use
other features in the Query Tool to execute and save the query and result set.
More information:

The Query Tool
Execute a Query

Change the Instance of an ODBC Connection
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Change the Instance of an ODBC Connection

If you have multiple copies of erwin Data Modeler (DM) running, the ODBC driver can only
serve data from one instance. By default, this is the first one started. If you want to change
which instance of erwin DM is handling the ODBC connection, you need to first stop the

driver on the one that is running and then start the driver on the second copy of erwin DM

from the same place.

To change the instance of an ODBC connection

1.

Go to the copy of erwin DM that is running for which you want to stop the ODBC
driver and click Options on the Tools tab.

The Options dialog opens.
Go to the Reporting tab and click Stop ODBC driver for this instance.

This button's display changes to Start ODBC driver for this instance once the ODBC
driver is stopped for the current instance.

Click OK.
The Options dialog closes.

Go to the other copy of erwin DM that is running for which you want to use the ODBC
driver and click Options on the Tools tab.

The Options dialog opens.
Go to the Reporting tab and click Start ODBC driver for this instance.

This button's display changes to Stop ODBC driver for this instance once the ODBC
driver is started for the current instance.

Click OK.

The Options dialog closes and you are ready to start constructing a query.
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Restrict Row Count in Query Results

When executing a query against a large model or database, you may want to restrict the
row count for the query. This causes the Query Tool to process only the first n number of
rows indicated in the number field. This may be helpful if you have executed a query that
returns lengthy results, but the section of the results that you would like to see is contained
in the first 100 rows, for example. In this case, enter 100 in the Restrict row count to number
field, and the query will only return the first 100 rows.

To restrict row count in query results
1. On the ribbon, click the Tools tab.

2. Click Query Tool.
The Query Tool opens.

3. Select the Restrict row count to check box, and enter a number in the adjoining box.

|:| Restrick row count bo: I:I

When your query runs, the results that display are restricted to the first n number of

rows you indicate.

More information:

Execute a Query
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Save a Result Set to a CSV File

After you have executed a query and the results display in the Results box, you can save the
results to a *.csv (comma-separated values) file to work with it in other reporting tools, or

to share with your modeling team.

To save a result set to a *.csv file

1.
2.

On the ribbon, click the Tools tab.

Click Query Tool.
The Query Tool opens.

Open a query file or create a new query and click the Execute [+ icon on the toolbar.
Your query results display in the Results box.

Click the Save Result Set as CSV [ icon displayed next to the Restrict row count to
box.

The Save As dialog opens.
Enter a file name and location for your file and click Save.

The file is saved, the Save As dialog closes, and you are returned to the Query Tool.

More information:

The Query Tool
Execute a Query
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The Report Designer

Report Designer lets you create a wide variety of reports and on the current data available
in your data models. If you are working in the Workgroup Edition, you can create Mart
administrative reports and cross-model reports. You can create report templates for fre-
qguently used reports and you can export reports to HTML and CSV formats. You can create
report solutions and include multiple report templates.

You cannot reuse the .RTB reports that were created using Report Template Builder,
because the metamodel objects are changed. You must recreate the reports in Report
Designer.

Several sample (pinned) reports are included with the application and they are available in
the following location:

$Installdir%$\erwin\Data Modeler r9\BackupFiles\Report Solutions
Also at the following location:

Windows 7

C:\Users\<user name>\AppData\Locall\erwin\Data Model-
er\9.8\Report Solutions

The pinned reports are created using a Logical-Physical model. If you use the pinned
reports with a Logical-only or a Physical-only model, it may result in inappropriate results.
Follow these steps:
1. Click Tools, Report Designer. The erwin Report Designer window opens.
2. To create a report solution, click Create new solution for reports on the toolbar.

If the current report solution is not saved already, you are prompted to save it. A new
blank workspace appears.

3. To create a report template, follow these steps:
a. Click Create a Report on the toolbar. The Report Editor dialog appears.

b. Enter a name for the report.
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C.

Select the model type that you want to report on. Select Mart to create a report
on the Mart data.

The items in the Select Report Subject pane change according to the Report
Type that you select.

I You must have the Reports: View permission to create Mart reports.

In the Select Report Subject pane, select the item on which you want to gen-
erate the report.

In the Select Report Fields pane, select the fields that you want to include in the
report.

To create a report that filters specific objects and includes them in the report,
use the Filter by option. This option is available only for entities, tables, attrib-
utes, columns, subject areas, and indexes..

Click Run Report.

If you are creating a report on your Mart and you have selected an option under
Filter By, the Mart Report Filter dialog opens.

Select the specific models that you want to get the results from. Enter the spe-
cific model object name. Use wildcard characters, if necessary.

The report is generated and displayed. If you do not specify any model or entity,
the generated report includes all the models. If you have used a wildcard, by
default, the wildcard is applied to all the names. For example, if you type ID, the
report includes Cust_ID and ID_For_Category. If the result is very large for Mart
reports, the report is displayed in multiple pages (data grid). Use the nav-
igational icons in the toolbar to view the subsequent pages.

(Optional) Click the Clear data in data grid icon to clear the results in the grid.
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4. To configure report preferences, follow these steps:
a. Click Edit, Preferences. The Report Designer Preferences dialog appears.

b. Complete the following fields and click OK:

Add object type as prefix for the properties 'Name' and 'Physical Name'

Prefixes the object type to only the Name and Physical Name columns.
For example, you are generating a report on entities and the cor-
responding attribute names and data types. The column names in the
report are displayed as Entity Name, Attribute Name, and Attribute
Logical Data Type.

Add object type as prefix for all other properties

Prefixes the object type to all columns.

These options work only when they are selected at the time of creating a
report. If these options are selected at the time of modifying an existing
report, they do not work.

Apply optimization mode if row count is more than

Specifies the number of rows at which the computer resources are optim-
ized to display the report. If the row count in your report exceeds the
number that you specify here, the report is displayed in optimization
mode. In this mode, the group and sort options are not available in the
result grid. If no value is entered, the row count for optimization mode is
considered as equal to the total row count of a report.

Number of top rows to display

Specifies the number of top rows that you want to display. This option dis-
plays the first few rows that match a report criteria, when the result con-
tains more rows than the number specified here.

5. To generate a report from an existing report template, select the template, right-click,
and click Run.
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6. To modify an existing report template, select the template, right-click and then click
Properties. After you finish modifying, restart erwin DM. Your changes will take effect
when you run the report again.

When you modify an existing report template and select more properties for the
existing report subject, the selections are retained. If you select a different report
subject, the previous report subject and its properties are not included in the
report.

7. To customize the appearance of the report at the node-level, follow these steps:

a. Right-click the node and click Properties. Complete the following fields:

Name
Specifies the name of the node. By default the name of the selected
object is displayed.
HTML Style
Font Family: Specifies the font for the selected node.
Size: Specifies the font size for the selected node.

Roll up subtables: Specifies that you want to display a parent and its child
node details together. This option is not effective when the report has
only one node. The following image illustrates a report without selecting
the Roll up subtables option:
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Entity/Table(s) of Model "EMOVIES r8"

MOVIE RENTAL RECORD
MOVIE COPY
CUSTOMER

CUSTOMER CREDIT

Detals...

Detals...

¥* Entity Name AntributefColumn Check Constraint Usage
EMPLOYEE Detalls, . Detalls..
MOVIE Detals Details..
STORE

MOVIE_STORE Details..
PAYMENT Details. Details..
Total ©

Attribute/Column(s) of Entity/Table "EMPLOYEE"

Arribute  Auribute Attribute fColumn  AntributefColumn  Auribute fColumn Attribute fColumn DEfaUk. R (Elize .
# S - - Constraint Domain Constraint

Name Definition Is FK Is PK Null_Option Physical_Data_Type

Usage Usage
employee Employee’s name  false false Mull WARCHARZ(20) Details.. Details..  Details..
first name
employee First line of the false false Mull WARCHARZ (20 Details.. Details..  Details..
address employes’s

address

employee Employee’s home  false false Mull IMTEGER. Details.. Details..  Details..
phone phone number

The following image illustrates a report when the Roll up subtables option is selected:

Entity/Table(s) of Model "EMOVIES r8"
Default
& Entity N Attribute  Atribute Attribute fColumn  Attribute fColumn  Awribute fColumn  Auribute fColumn Constraint
nuty Name Name Definition Is FK Is PK Null_Option Physical_Data_Type Usage
Name
EMPLOYEE employee Employee’s  false false Hull VARCHARZ2(20)
first name  name
EMPLOYEE employes First line of false false MHull VARCHARZ2 (20}
address the
employee’s
address
EMPLOYEE employes Employee’s  false false MHull INTEGER.
phone home phone
number
EMPLOYEE employee  3econd line  false false Hull VARCHARZ2(20)
address 2 street
address of
the
employee

Foreground: Specifies the text color.

Background: Specifies the background color.

Template Color: Specifies that the color that is specified in the template is used.
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Bold/Italic/Underline/Strikeout: Specifies the effect for the text.

Width: Specifies the width of the selected node (report column). You can specify the
width for any node and it is applied when the report is exported to HTML.

Alignment: Specifies the alignment of the text.
8. To export a report solution to HTML, follow these steps:

. Right-click the report solution and click Export All to HTML. The Report Export
dialog appears.

" Click Browse and select the folder to which you want to export the report.
" Go to the HTML tab and add the title in the Solution Title in HTML field.
" Click OK. The report is generated in the specified folder.
9. To export a report to HTML, follow these steps:
a. Click the Clear data in data grid icon and clear the result grid.

This is a best practice and helps the application export the report without con-
suming much of the computer resources.

b. Right-click the report and click Export to HTML. The Report Export dialog
appears.

c. Click Browse and select the folder to which you want to export the report.

d. Go tothe HTML tab and complete the following fields:

Select the template for exporting to HTML

Specifies the templates that you want to use with the HTML report. You
can use customized templates, provided the formatting is similar to the
default templates. However, if you modify HTML templates, you must
restart erwin DM for the changes to take effect.

The default templates are available in the following folder:

C:\Program Files\erwin\Data Modeler r9\Report\Template\Template-
Default

Solution Title in HTML

Specifies the title for the entire report solution.
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Report Header in HTML

Specifies the text that appears between the report title and the first line
of the report.

Report Footer in HTML

Specifies the text that appears at the bottom of the report.

Click OK. The report is generated in the specified folder. If the report data spans
multiple page grids in the Report Designer, the data is segregated into multiple
sections in the HTML. The sections are first divided by model name and then by
object name. This means that a section may include objects from different mod-
els, which are sorted by model name and object name.

10. To view the HTML report on a different computer, include the computer name in the
path to the filename. For example, if you have published the report to c:\er-
win\reports folder on a computer that is named Comp001, use the following path to
access it:

\\compOOl\erwin\reports\index.htm

The computer from which you are accessing the report must be in the same domain
as the one in which the report is published. In addition, the user who is accessing
the report must have at least the read-only privileges on the corresponding folder.

11. To export a report or a report solution to CSV, follow these steps:

a.

Right-click the report and click Export to CSV. Or, right-click the report solution
and click Export All to CSV. The Report Export dialog appears.

Click Browse and select the folder to which you want to export the report.

Go to the TEXT tab and select the following options:

Format

Specifies whether you want to include the first-level object names mul-
tiple times. For example, you have included entity names and attribute
names in your report and you have selected No Duplicates. The entity
name appears only once for all the corresponding attribute names. If you
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have selected Duplicates, the entity name appears as many times as the
corresponding attribute names appear.

Text Qualifier
Specifies the symbol that you want to use to indicate the column headers.
Delimiters

Specifies how you want to separate two columns in the exported report.
The option Comma Delimited creates a .CSV file and the remaining
options create .TXT files.

d. Click OK. The report is generated in the specified folder.
12. To add a report from another report solution, follow these steps:

" In the Report Designer dialog, right-click the template name and click Add
Report.

" Select the report that you want to include (.erpt file) and click OK.

" Save the report solution.
The Filter By Option

Report Designer includes the Filter By option that lets you generate drill-down reports.
Some of the drill-down reports that you can generate are as follows:

Entity/Table level reports

" Entities and tables in the current Subject Area

" Entities and tables that are selected in the current diagram
Attribute/Column level reports

" Migrated attributes and columns

" Owned attributes and columns

" Role-named attributes and columns

" Foreign (FK) Key groups and indexes

" Generated indexes

" Nonunique (IE) Key groups and indexes
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" Primary (PK) Key groups and indexes
" Unique (AK) Key groups and indexes
Subject Area reports:
" All entities and tables in the current subject area
" Members of the current diagram
" Members of all the diagrams in the current Subject Area

" Members of all the diagrams in the Main Subject Area, that is, the members of all dia-
grams at the model level

" Members of the diagrams that are specified at run time

You can use the Graphical Member option for diagrams and can view the images of dia-
grams.

The filters for Entity/Table and Key Group/Index are available when you select the members
of a diagram or a Subject Area.

Attributes and columns can be displayed the following order:
" Alphabetic
" Attribute (the order in which attributes appear on the logical model)
" Column (the order in which columns appear on the physical model)

' Physical (the order in which columns appear in the DDL after Forward Engineering)

" Reverse Alphabetic
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Report Designer Features

Report Designer includes the following features:

Count Objects

Based on the Report Type selection on the Report Editor, it displays the count (number) of
Subject Areas, Entities/Tables, Attributes/Columns, Key groups/Indexes, and Relationsips
that are present in the model. You can export this count to CSV format. On the Report
Designer, click Export > Export Count to CSV.

Report Explorer Features

Move child nodes: To move the child nodes up or down within a parent node, right-click the
node and click Move Up or Move Down. This option is to move child nodes within a parent
node and not to move parent nodes in a report.

Result Grid Features

Drag-and-drop: To change the order of columns, drag-and-drop the report node to
the desired position in the Report Explorer pane. Select the report template and click
Run current report on the toolbar.

Sort: To sort the report results on a specific column, click the column header. The
default sort order is the order in which you have created the objects in the model.

Hide a column: To hide a column, click the column header and drag it away from the
report until you see the cross mark. To display a hidden column, right-click a column
header, click Columns, and then select the column that you want to display.

I Hidden columns are included when you export a report to CSV or HTML.

Group the report result by a column: To group the report result by a column, click the
column header and drag it to the Drag a column header here to group by that column
section. The following illustration shows a report that is grouped by two columns:
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T
Tahle Physical_Marme |

Column Physical_Mame | Column Physical_.. Index Physical_M...
Filter k... Filker k... Filter k...

= Type: Dependent

=1 Table Physical_Marme: KOWIE_COPY

general_condition warchar{20) HPEROWIE_COPY
rmiowvie_format warchar(Z0) HIFIRAONTE_COPY
rnovie_copy_number  integer

Fricvie_nurmber integer

=1 Table Physical_Marme: BOWIE_REMTAL_RECORD

rental_date datetime HPEMONWIE_REMT...
due_date datetime HIFSRAONIE_REMT...
rental_status wvarchar(20) HIF4RAONTE_REMNT ...
overdue_charge integer HIFaMOWIE_REMT...
rental_rate integer HIFTRAONIE_REMNT...
rental_record_date datetime HIFARAONTE_REMT...
soc_sec_numhber integer

employee_phone inteqer

Rename a column: To rename a column, right-click the corresponding node in the
Report Explorer and click Properties. Enter a new name in the Node Name field and
click OK. Select the report template and click Run current report on the toolbar.

Configure the look and feel of each column: To configure the look and feel of each
column, right-click the corresponding node in the Report Explorer and click Properties.
Complete the fields in the Customize report style section. Be aware that the styles
applied to a parent node are not applied to child nodes automatically.

Clear grid: To clear the data displayed in the result grid, click View, Clear gird. Clearing
the result grid is a best practice when exporting a large or a complex report to HTML.

Export to HTML and TXT: To export a report or a Report Solution, right-click it and
click Export to HTML or Export to CSV. When you export a report to CSV, select the
delimiter as Comma Delimited to view the report in CSV format.

Pinned Reports
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You can open the built-in reports from the Open pinned reports from disk toolbar item. The
pinned reports are available in the local computer of the user. The reports are segregated
into categories and each category of reports is available in a separate folder. You can create
a folder of your own add the reports of your choice to it.

Several sample (pinned) reports are included with the application and they are available in
the following location:

$Installdir%$\erwin\Data Modeler r9\BackupFiles\Report Solutions
Also at the following location:

Windows 7

C:\Users\<user name>\AppDatal\Locall\erwin\Data Model-
er\9.8\Report Solutions

The pinned reports are created using a Logical-Physical model. If you use the pinned
reports with a Logical-only or a Physical-only model, it may result in inappropriate results.

Reports that are copied directly under this folder do not appear in the Pinned Reports dia-
log. The reports must be in a subfolder under this folder.
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Subject Area Reports

By design, a model is considered as the main Subject Area. Therefore, when you create a
generic report on Subject Area and include its properties such as Name, the model is also dis-
played in the list of Subject Areas. However, the model name is not included when you gen-
erate a report on specific Subject Areas. You can generate a report on specific Subject Areas
by selecting the Specify Diagrams at Run Time option.

The following diagram shows a generic report of Subject Area:

“op ot BT ik Crag a column header here to group by that column,

= T_emplates ‘default’ (1 reports)

: Subject Area MName
[ =

Filter by...

Accounting

Custormer

Ernployees

ke

In the previous report, <model> is the model and the remaining entries are Subject Areas.

If you generate a Subject Area report for a Mart model, <model> is not included as a Sub-
ject Area. To generate a Subject Area report, we recommend that you open the Mart
model and generate the report as a "local" model.
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Change the Logo on the HTML Report

By default, erwin logo is displayed on HTML reports and the logo is linked to the erwin web-
site. You can change the logo and link it to a website of your choice.

Follow these steps:
1. Open the folder where erwin® Data Modeler is installed.
Navigate to the \Report\Template\Template-Default\_images folder.
Replace the image in the logo.png file.

2
3
4. Navigate to the \Report\Template\Template-Default folder.
5. Open the list.htm file in an HTML editor.

6

Replace http://www.erwin.com with the required URL, as shown in the following

image:

Mame Date modified Type Size
_images 121147206 %49 P File folder
D""'dm‘-‘n - A0 NN E C AN DL | ' B 0 N
Bhsin-htrrl 4 list htm - Motepad

 indechtm file Edit Format Miew Help

€ listhtm }

& welcomehtm ¢/styler

< fhead>
<BODY BGCOLOR=#FFFF99 TEXT=#000008 link=#800608 V1ink=#008088 Alink=#998600>
<p align="center"»
<a href="http://waw.erwin.con” target="REPWINDOW"»
<img src="_images\logo.png" border="8" height=108px width=180px»</a»

ofp

7. Restart the application.

The logo and the link to the website are changed when you generate a report the next
time.
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Generating TLX Reports

A TLX report is a model validation report that uses erwin Template Language (TLX). Report
Designer includes some default validation reports and also lets you configure new reports
with custom properties. You must be familiar with erwin Template Language (TLX) to con-
figure new reports.

When you configure new reports, you can add two types of custom properties, filters and
TLX properties. The code for a filter includes a function that returns TRUE or FALSE.

Generate a Default TLX Report

Report Designer includes default TLX reports at entity/table, attribute/column, domain, and
relationship level. Some of the properties that are included in the default TLX reports are no
definition or no primary key. This topic describes how you can create an entity/table level
report as an example. You can create other TLX reports on the same lines as described in the
procedure.

To create an entity/table level report, follow these steps:
1. Click Tools, Report Designer, Create a new report.
2. Select Logical/Physical for Report Type.
3. Click Entity/Table in the Select Report Subject pane.
4

. In the Select Report Fields pane, expand Filter By and select the No Definition and No
Comment check boxes.

U

Expand Properties and select Name, Physical Name check boxes.
6. Click Run Report.

The list of entities and tables that do not have a definition or a comment is displayed.
Create a Custom TLX Report

If you are familiar with TLX scripting, you can add your own functions for properties of your
choice and configure custom reports. For example, you can create a report that gives the
number of attributes in each entity. You can add two types of custom properties, filters and
TLX properties. The code for a filter includes a function that returns TRUE or FALSE.
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To configure a new report, you must modify the following configuration files:
" TLXReportAssembly.xml
. TLXReportTemplate.FET
These files are available in the <erwin install folder>\Report\TLX folder.
Follow these steps to create a custom TLX report:

1. Modify the TLXReportAssembly.xml file and include the TLX property that you want to
report on.

2. Modify the TLXReportTemplate.FET file and include the function for the custom prop-
erty.

3. Restart erwin Data Modeler.

4. Create areport in the Report Designer and select the TLX property that you have
added.

5. Run the report.
Modify the TLXReportAssembly File

To display a property under the Filter By node or the Property node in the Report Designer,
you must add an entry for the property in the TLXReportAssembly file.

The TLXReportAssembly.xml file includes the following parameters:

Assembly ID

Specifies the unique identifier for the property entry in the TLXReportAssembly file.
You can enter any number of your choice, as long as it is unique within this file.

OwnerlD

Specifies the owner ID for the object for which you want to create a custom property.
Use the following owner IDs:

Owner ID Object

1075838979 Entity/Table
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1075838981 Attribute/Column
1075838983 Domain
1075839016 Relationship
1075838985 Key Group
1075838978 Custom Template

1075839014 Subject Area

Name
Specifies the name of the custom property the way it appears in the Report Designer.
ExtractType

Specifies the type of report for which the custom property is available. 1 denotes
Logical, 2 denotes Physical, and 3 denotes Logical/Physical.

DBMS Info

Specifies the database for which the custom property applies. Enter the information
in the format, "database brand code, major version number of the database, minor
version of the database."

A value of "0,0,0" indicates that the custom property applies to all databases. The fol-
lowing table provides the DBMS information for the databases that the current
release supports:

Database DBMS Info in
TLXAssembly
AlloyDB (1075918980, 1, 1)
ArangoDB (1075859217, 3, 0)
Apache Avro 1.x (1075859205, 1, 0)
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DBMS Info in

Database TLXAssembly

Amazon Keyspaces

(1075859223, 2, 0)

Azure Synapse

(1075859211, 10, 0)

Cassandra

(1075859199, 3, 0)

Couchbase 6.x

(1075859202, 6, 0)

Couchbase 7.x

(1075859202, 7, 0)

Databricks (1075859232, 1, 0)
Db2 for i 5.x/6.x/7.x (1075859019,4,0)
Db2 for LUW 9.5 (1075858977,9,5)
Db2 for LUW 9.7/10.x (1075858977,9,7)

Db2 for LUW 11.1

(1075858977,11,1)

Db2 for z/OS 8.1

(1075858978,8,1)

Db2 for z/OS 9.1/10/11

(1075858978,9,1)

Db2 for z/OS 12 (1075858978,12,0)
DynamoDB (1075859229,19,0)
Google BigQuery (1075859226,2,0)
Hive 2.1.x (1075859187,2,1)

Informix 10.x/11.x/12.x

(1075859008,9,2)

JSON 1.x (1075859208, 1,0)
MongoDB 4.x (1075859196,4,0)
MongoDB 5.x (1075859196,5,0)
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Database

MongoDB 6.x

DBMS Info in
TLXAssembly

(1075859196,6,0)

MariaDB 10.4.x

(1075859190,10,4)

MySQL 8.x

(1075859129,8,0)

Neo4j4.2.x

(1075859214, 4, 2)

Neo4j4.3.x/4.4.x

(1075859214, 4, 3)

Netezza (1075918978,7,2)
ODBC/Generic 2.x (1075859009,2,0)
ODBC/Generic 3.x (1075859009,3,0)

Oracle 12cr2

(1075858979, 12, 0)

Oracle 18c (1075858979, 18, 0)
Oracle 19c (1075858979, 19, 0)
Oracle 21c (1075858979, 21, 0)
Parquet 2.x (1075859220, 2, 0)
PostgreSQL 9.6.x/10.x/11.x/12.x/13.x/14.x/15.x | (1075918977,9,6)
Progress 9.x/10.x/11.x (1075859010,9,0)

Redshift 1.0

(1075918979,1,0)

SAS

(1075859013,1,0)

SAP ASE 15.x/16

(1075859017,12,5)

SAP 1Q 15.x/16

(1075859130,15,0)

SQL Server 2012

(1075859016,11,0)
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Database DBMS Info in
TLXAssembly
SQL Server 2014 (1075859016,12,0)
SQL Server 2016/2017 (1075859016,13,0)
SQL Server 2019/2022 (1075859016,15,0)
SQL Azure (1075859016,16,0)
Snowflake (1075859193,4,10)
Teradata 14.10 (1075859018,14,10)
Teradata 15.x/16.x (1075859018,15,0)

TLXFunction

Specifies the TLX function name for the custom property. The function name can be
any name that describes the property.

Is Filter

Specifies whether the custom property is a filter or a property. Include a value of 1 for
filter and O for property. If you include 1, the property is displayed under the Filter by
node of the corresponding object. If you include O, the property is displayed under the
Properties node of the object in Report Designer.
Follow these steps:
1. Open the TLXReportAssembly.xml file in a text editor such as Notepad.
2. Add a line for the property that you want to include in the report.

3. Save the file.
Modify the TLXReportTemplate.FET File

The TLXReportTemplate.FET file includes the functions that help the Report Designer gen-
erate the report for a TLX property. You must modify the file to include the function for a
custom property for which you want to generate a report.
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I Use the same function name in the TLXReportAssembly and TLXReportTemplate files.

Follow these steps:
1. Open the TLXReportTemplate.FET file in a text editor such as Notepad.
2. Add the TLX script for the property that you want to include in the report.

3. Save the file.

Now the custom property appears in the Report Designer under the corresponding

node. You can include the property in a report.

Example--Number of Attributes in an Entity

This example demonstrates how you can generate a report on the custom property Number

of Attributes in an Entity. This property is of type TLX property.

Follow these steps:

1. Add an entry to the TLXReportAssembly.xml file to create a node for Number of Attrib-

utes in Report Designer.
2. Add the TLX function NumberofAttributes to the TLXReportTemplate.FET file.

3. Create a report and include the Number of Attributes property.
Add an Entry to the TLXReportAssembly.xml File

Follow these steps:

1. Open the TLXReportAssembly.xml file from the <erwin install folder>\Report\TLX
folder.

2. Add the following entry and save the file:

<Assembly Id="1002" OwnerId="1075838979" Name="Number of
Attributes" ExtractType="1" DBMSInfo="0, 0, 0" TLXFunc-
tion="NumberofAttribute" IsFilter="0"/>

Add the TLX Function NumberofAttributes to the TLXReportTemplate.FET File

Follow these steps:
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Add the following code to the TLXReportTemplate.FET file and save the file:
SPItemBegin = NumberofAttribute
[

Set ("Count", 0)

ForEachOwnee ("Attribute")

{

Increment ("Count")

}

Value ("Count")
]

SPItemEnd
Number of Attributes is added to Report Designer under Entity, Properties.
Create a Report and Include the Number of Attributes Property

Follow these steps:
1. Open Report Designer.
2. Select the Report Type as Logical.
3. Inthe Select Report Subject pane, select Entity.
4

. In the Select Report Fields pane, expand Entity, Properties, and select Name, Number
of Attributes.

5. Click Run Report.

erwin DM Navigator Edition User Guide | 131



Dimensional Modeling

Dimensional Modeling

The ability to produce reports on data source mapping is added to Report Designer in
erwin® Data Modeler Release 9.5.2. In the data warehouse environment, it is important to
track the following information:

" Source of the data.

" The method by which the source data is extracted and cleansed before it is imported
into the data warehouse.

" The frequency and timing of data warehouse updates.

You may have a data warehouse that combines information from several online transaction
processing (OLTP) systems and archived data into a single decision support system. Your
data may also come from relational and non-relational sources. To support regular updates
and data quality checks, you must know the source for each column in your data ware-
house. You must also know when and how the data is updated. You can document all of this
information using erwin® Data Modeler. This information can also be produced as reports in
various formats using Report Designer.
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Report on Data Sources, Target Columns, and Transformations

This report includes the list of data sources, target columns, and the corresponding trans-

formation details.

To generate this report, you must have a model that documents data movement sources
and has the column level mappings defined.

Follow these steps:

1.

N oo v ok~ W N

10.

11.
12.

13.

Open erwin Data Modeler and open a model in which data movement sources and
column level mappings are defined.

Click Tools, Report Designer.

Click Create New Report. The erwin Report Editor dialog opens.

Enter the title of the report as ETL Mapping.

Enter a name for the report and select the Report Type as Logical/Physical.

Select the Report Subject as Entity/Table.

In the Select Report Fields pane, expand Entity, Properties, and select Name, Defin-
ition.

Expand Entity/Table, Properties, and select Comment, Dimensional Notation Role
Type, and Physical Name.

Expand Attribute/Column, Properties, and select Comment, DS Comment, Name, Null
Option, and Physical Data Type.

Expand Data Source Column/Data Movement Column, Properties, and select Name,
Physical Data Type.

Expand Data Source Table/Data Movement Table, and select Name.

Expand Data Source Object, Properties, and select Name, Data Source System, Data
Source Type.

Expand Attribute, Key Type and select Is PK, Is FK.
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14. Cick OK. The report template is added to erwin Report Designer.

2
&) Entity/Table
Phiysical Name
Comment
Dimensional Motation Role Type
= Artribute/ Celurmn
Attribute Mame
Column Name
Comment
D5 Cormment
Is FK
Is PK
Mull Crption
Data Type
= Data Source Column/Data Movernent Column
Data Source Column/Data Movemnent Column Name
Physical Data Type
= Data Source Table/Data Movement Table
Data Source Table/Datas Movernent Table Name
= Data Source Object
Data Source Object Name
Data Source System
Data Source Type

15. In erwin Report Designer, right-click the template and click Export to TEXT.

The report is generated and displayed.

File Edit View Export Help

P

pESRR RS RE L Ifka ce e

q |
I.'illr \E_xport to TEXT format ]der hu
=

= Templates 'default’ (1 reports) LL

R ETL Mapping
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16.
column.

Verify that the report contains data source mapping information for each target

— —
FrCECEE P R W W SR W W W Do Viow et Mapping Repor.cv < Miciotoft Eecdl®
m Home | Tnsert Fage Layout Formulas Data Review View
[Eﬂ ¥ Cut Calibri * 11 - A A ﬁwrap Text General - El H MNormal
i =& Copy ~ =
Paste Frormatpamter B £ T 7 G- A - EiMerge & Center - § ¢ % v b 5% Fc:rr':;l;l::nr;al- ﬂ:&;;rgla: Good
Clipboard ] Font [F1 Alignment [F1 Number ] sy
i B15
A
EB subject Area ER
2 <model> Fact and dimensions dim_date day number Mot
3 |<model> Fact and dimensions dim_date day_date MNull
4 |<model> Fact and dimensions dim_date week_number MNull
5 <model> Fact and dimensions dim_date month_number Mul
6 | <model> Fact and dimensions dim_date year_number MNull
7 | <model> Fact and dil ions dim_geographic geographic_area MNod
8 |<model> Fact and dil ions dim_geographic geographic_area_name Mull
9 | <model> Fact and dil ions dim_geographic region Mull
10 | <model> Fact and dimensions dim_geographic country Mulj
11 |<model> Fact and dimensions dim_geographic other_region_details Mull
| 12 |<model> Fact and dimensions dim_customer account_number Mull
13 | <model> Fact and dimensions dim_customer customer_name Full name of the customer <Last Name>,<First Name> MNull
14 |<model> Fact and dimensions dim_customer address complete address should include street and pin code  Nulj
E(mudel) Fact and dimensions -dim_custurner customer_type customer type MNull
16 <model> Fact and dimensions dim_customer customer_type customer type MNull
17 |<model> Fact and dimensions dim_customer customer_type customer type Mull
18 <model> Fact and dimensions dim_customer customer_key Mot
19 | <model> Fact and dimensions dim_customer customer_id Mulj
| | 20 <model> Fact and dimensions dim_product roduct code Notf
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Report on Data Lineage with Diagrams

This report includes the data lineage (data source mapping) with diagrams.

To generate this report, you must have a model that documents data movement sources
and has the column level mappings defined.
Follow these steps:

1. Open erwin® Data Modeler and open a model in which data movement sources and
column level mappings are defined.

Click Tools, Report Designer.

Click Create New Report. The erwin Report Editor dialog opens.

Enter the title of the report as Browse ETL Mapping.

Enter a name for the report and select the Report Type as Logical/Physical.

Select the Report Subject as Entity/Table.

N oo s~ w N

In the Select Report Fields pane, expand Entity, Properties, and select Name, Defin-
ition.

8. Expand Subject Area, Properties, and select Name.

9. Expand ER Diagram, Properties, and select Name.
10. Expand Members, Table/Entity, Properties, and select Table Physical Name.

11. Expand Attribute/Column, Properties, and select Comment, Physical Name, Null
Option, Physical Data Type, DS Comment.

12. Expand Data Movement Column, Properties, and select Name, Physical Data Type.
13. Expand Data Source Table/Data Movement Table, and select Name.

14. Expand Data Source Object, Properties, and select Name, Data Source System, Data
Source Type.

15. Expand Attribute, Key Type and select Is PK, Is FK.
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16. Cick OK. The report template is added to erwin Report Designer.

= Browse ETL mapping{HTML)
&) Subject Area
Subject Area Name
&= ER Diagram
ER Dvagram Name
= Entity/Table
Takle Physical Name
= Attribute/Column
Colurmn Physical Name
Comment
Transform comment (05 Comment)
kB FK
EPK
Mull Opticn
Physical Data Type
= Source
Source Column Name
Physical Data Type
= Source Table
Seurce Table Physical Mame
= Dwta Source Olbject
Data Source Object Narme
Data Source System
Data Source Type

17. In erwin Report Designer, right-click the template and click Export to HTML.

The report is generated and displayed.

He Edt Vew Faoses Tk Help
x 0 S Bmanr Wbk
e
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3 Datly Movement B dim_product e ncocd
Tramfor Data
mﬁ’&;‘fm product_cod: Column Dereaen, Wl Optism  ToPEAl
Fewan product_name [y Notd  CHAROE)
e descrpien T
HENL Speciicaton .““_%.41‘31“;‘ Swie  Colwmn
e — Tyee
! o
: I o Tabie
1 Mame
Producny
Dtact rewrus
fart jd
Fdim grographic e —————— & i custoner
geographic_are PDALCL_ vt (I customer_key.
day_rumber (FK; =
050 BOR_E0E LTS fact name acoont
m = = = =64 fact_gecontion B custoenr_id
foc_smount custmal_name
Gttt fact_count customar fype
offwr_fact detals addiess
custorer_key 75
W customer registrabon systam I e L CHaRrIE)
I order processing systam | r—— Newd CRRNE
| fecid [ Rl
4_ fctseme wt csm
% dim_dato facs duncripon o 18]
B i r—r | o focamom  Guwmn ' Ml cranle
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18. Open the HTML report and verify the data mappings. Verify that the report contains
diagrams and clickable entities through which you can navigate to the data source
mapping information.

Click here to view a video demonstration of this report.

erwin DM Navigator Edition User Guide | 138



Product Differences

Product Differences

This section contains the following topics:

erwin Data Modeler Navigator Edition Differences

Data Model Disabled Menu Items and Toolbar Icons
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erwin Data Modeler Navigator Edition Differences

You can use this product to view, manipulate, print, and report on models on a local drive,
network, or on a mart database.

The toolbar, menu and dialog options that are unusable in the components of this product
are either absent or grayed out to show that they are disabled. For experienced users who
are already familiar with erwin® Data Modeler, the options that are not available in this
product are specified in the following sections.
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Data Model Disabled Menu Items and Toolbar Icons

The following menu items and their corresponding toolbar icons are unavailable when you
are working with data models using erwin Data Modeler Navigator Edition:

File
Save
Save As
Mart, Save
Mart, Save As
Mart, Lock
Mart, Version Manager
Mart, Library Manager
Mart, Session Manager
Mart, Security Manager
Export to External Format
Actions
Database Connection
Reverse Engineer
Forward Engineer (all rollover menu items)
Design Layers (all rollver menu items)
Tools
Standards (all rollover menu items)
Add-Ins (all rollover menu items)
Options
Report Designer

Export to PDF
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